Introduction to TK Solver
This document begins with a rapid tour of TK Solver’s interface, solvers and
programming features as might be used in a training session. TK Solver can do such a
broad variety of things that it’s best to be equipped with the fundamentals rather than try
to master the concepts from working examples.
A given problem might be solved in a variety of ways – paper and pencil, calculator,
spreadsheet, programming language, math program – but TK Solver is the best way to
build a versatile solution. That is, once a problem has been solved by building a
mathematical model TK, related problems can be solved with very little additional effort.
That will be a recurring theme of this introduction.
At its core, TK Solver is a rule-based problem solving and math modeling environment
that combines equation solving, unit conversion, interpolation tables, and user-defined
procedures. The rule-based features can be accessed from a variety of problem solving
and application building shells.

A List Solver can be used to repeatedly process the math model over ranges of inputs to
generate tables and plots of solutions. The list solver can also be used in Monte Carlo
simulations, filtering distributions of random numbers through the rules and summarizing
the results.
An Optimizer can be used to repeatedly process the math model until some target
solution is achieved, subject to bounds and constraints on any variables and expressions.
An Excel Toolkit allows any of the objects (variables, units, lists, plots) from a TK model
to be interactively linked within a spreadsheet. These objects can also be linked
interactively with custom desktop and web-based applications created using other
programming languages.

The Interface
TK Solver manages different types of objects on worksheets. The object types are rules,
variables, lists, units, plots, tables, formats, and comments. Together, the objects can
form a mathematical model. The worksheet structure is accessible via the TK Navigation
Bar. (If you do not see the Navigation Bar, click on the View menu to activate it.)

Double-click on the icon or description of the sheet you need to access. If objects are
already present in a TK model, the Navigation Bar displays “+” symbols beside the sheet
icons. Click on the “+” to expand the display and show the objects on that sheet. If you
double-click on an object in the Navigation Bar, TK displays its attributes or properties.

You can also access an object’s properties directly from the worksheets, holding both the
keys Ctrl-D, or by right-clicking on the object.
TK also provides access to existing objects in a model via the Object Bar.

From the left, the Object Bar icons access functions, lists, plot definitions, table
definitions, and format definitions. The Object Bar also provides quick access to existing
plots, tables and comments.
Use the Navigation Bar to access TK sheets and create new objects. Use the Object Bar
to access existing objects.
Navigation Mode vs. Edit Mode
When you type information into a TK sheet, TK goes into “edit mode”. You see a single
blinking cursor at the data entry point. During this time, many of the icons and
functionality of TK’s interface are inaccessible. You will see that the icons become
grayed out. You cannot change to a different sheet when you are in edit mode.

When you have completed entry of the information in a particular field, the blinking
cursor disappears and the current field is completely highlighted. You are now in
“navigation mode”. When you are in navigation mode you have free access to all the
icons, menus and interface functionality.
TK Solver is a “Tool Kit” full of many solvers that all work together under your
direction. Here is a list of those solvers.
Direct Solver
Iterative Solver
Procedure Processor
Differential Equations Integrator
List Solver

Optimizer
TK Library of Root-Finders
Excel Tool Kit
TK’s Direct Solver performs inverse mathematical operations and inverts functions in an
equation to solve for a single unknown. If an equation contains more than one unknown,
the Direct Solver skips it and moves on. When it solves an equation, it applies what it
learns to subsequent equations, making additional passes through the rules to solve
previously bypassed equations and checking for inconsistencies.
For example, given inputs for any two of the three variables in the following equation,
TK’s Direct Solver will solve for the remaining variable. tand(theta/2) = radius/height, or
in TK’s MathLook view,
tand
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2

=
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The Direct Solver makes your life easier by allowing you to enter your equations in any
sequence and without having to isolate the unknowns to left of the equals sign.
TK’s Iterative Solver works with the Direct Solver to solve equations where the
unknown cannot be isolated or to solve systems of simultaneous equations. The Iterative
Solver sends a guess value to the Direct Solver, which works its way through the
equations until it detects an inconsistency in one of the equations. The Direct Solver then
tells the Iterative Solver how much of an inconsistency it found. The Iterative Solver
keeps sending the Direct Solver new guesses until the inconsistency is very close to zero.
The Iterative Solver can work with multiple guess variables if necessary.
For example, the following set of equations can be solved using TK’s Iterative Solver, if
inputs are given for theta and volume.
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The Iterative Solver can also be used to solve problems involving more complex
functions that are otherwise non-invertible. For example, the Iterative Solver can be used
to determine the upper limit (x2) of the following integral, given the lower limit (x1),
such that a desired area is achieved.
Area = Integral("1-sin(x)*cos(x),x",x1,x2)
Similarly, the Iterative Solver can backsolve the following rule to determine the pressure
at which water vapor, at a given temperature, will have a given density.
Rho = $density(1,’water,’T,T,’P,P)

TK Solver also includes a Procedure Language that allows for solving problems in a
sequence of steps. The procedure language is used to create user-defined subroutines
called Procedure Functions. Procedure Functions can be called as a subroutine by the
Direct Solver to do specific tasks such as stepping through a range of inputs, filling lists,
performing summations or products, etc. Procedure functions allow you to add any
algorithms to a TK model. Given an input value for C, the following procedure loops
through a series of calculations, returning the final value of S and generating a list called
XYZ with the cosines of each of the 100 intermediate values of s.
S=0
For I = 1 to 100
S = S + (C-I/1000)^-2
‘XYZ[I] = cos(S)
Next I
Suppose we need the output of this procedure to be 2.75 and we need to know the value
of C required to make that happen. The Iterative Solver handles it easily.
Some TK built-in functions automatically generate lists of solutions. For example, TK
includes a collection of integrators for solving differential equations. There is also a
Wizard to help set up the differential equations, initial conditions, solution tables, and
plots. As with procedure functions, the Iterative Solver can be used to backsolve these
integrators to achieve desired results.
Here is TK’s solution to the following differential equations, where y1(0)=0 and
y2(0)=0.2.
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Element
1
2
3
4
5
6
7

ODE_x1
0
.092603848
.187649488
.282441726
.377411345
.472887231
.569168717

ODE_y11
0
.019377624
.041039322
.064403466
.089522341
.116423086
.145114274

ODE_y12
.2
.21849121
.237275272
.255589567
.273262503
.290057758
.305677834

ODE_x1
19.8392069
19.8694777
19.8986642
19.9267374
19.953833
19.9800655
20

ODE_y11
-.29388033
-.23649045
-.17937409
-.12274748
-.066495
-.01052269
.0330106

ODE_y12
1.86533685
1.92670722
1.98741169
2.04697566
2.10527704
2.16216518
2.20546338

…..
Element
541
542
543
544
545
546
547

TK also includes a List Solver that will repeatedly run the entire math model, using lists
of values for any of the input variables. This is one way to generate tables and plots of
results. The List Solver can be set up manually or through the use of a Wizard. The List
Solver will call on the Direct and Iterative Solvers at each step of the process. Here is set
of TK rules used to solve fluid flow problems.
density = $DENSITY( 3 , fluid , 'T , T , 'P , P)
viscosity = $VISCOSITY( 3 , fluid , 'T , T , 'P , P)
w
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Here is a plot of the pressure drop vs. the tube diameter.
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List Solving can also be used to run through a series of random numbers from various
probability distributions. This is called Monte Carlo Simulation. TK’s Simulation
Wizard can be used to set up all the required parameters and evaluate the results.
The TK Optimizer repeatedly solves a TK model until a set of objectives are met. This
can involve finding a minimum or maximum value subject to sets of bounds and
constraints on any of the variables in the model. The Optimizer can call on the Direct
and Iterative Solvers at each step of the process.

The Optimizer can also be used as an alternative to the Iterative Solver for backsolving a
model to determine how an input must be changed so that one of the outputs results in a
desired value.

TK Solver includes a Library of pre-programmed procedures you can merge into your
own models. The Library, accessed via the Applications menu, includes hundreds of
tools divided into various categories.

The TK Library tools can be used to solve specific problems within a math model,
freeing the other solvers to tackle other tasks. The Library tools also add to the available
root-finders in TK. Here is a quick summary of the root-finders in the TK Library.
Quadratic Equations
Cubic Equations
Quartic Equations
Nth Order Polynomial Equations by Bairstow’s Method
Bisection Method
False Position Method
Newton’s Method
You can see these tools in action by loading the examples from the TK Library before
merging in one of the tools.

Finally, the TK-Excel Toolkit provides another level of solving power. The TK-Excel
Toolkit allows you to run any number of TK models as subroutines within an Excel
spreadsheet. The TK cells can also be referenced from other cells in Excel. The outputs
from one model can be linked to the inputs in other models. The linked TK models can
be called to List Solve to generate tables of solutions that can also be linked with Excel.
The Excel Solver add-in can be used to optimize the results from this entire combination.
Here’s a portion of linked spreadsheet showing some TK variables and a plot.

Practice
Let’s begin with some practice with the interface. Launch the program.
Opening Sheets and Creating Objects
1. The toolbar automates several of the menu commands. You can see “tool tips” by
moving the pointer over the icons.
2. The Navigation Bar provides fast access to the various sheets. Double click on a sheet
name to open it. Sheets can be minimized or maximized by clicking on the icons in the
upper right corner of each window. Alternatively, windows can be closed by clicking the
button in the upper right corners.
3. Open the Plot Sheet. Enter p1 in the name column.
4. Move to the second row on the Plot Sheet and enter plot2. Now there are 2 objects.
FACT: TK sheets can hold up to 32,000 objects if necessary!

5. Cursor down to the third row on the Plot Sheet and try to enter 2ndplot. When you try
to enter it, TK displays an error message. 2ndplot is an invalid name.
6. Click the Context-Sensitive Help button. In this case, TK displays complete
information about how to enter names, what characters are valid in names, and other
related information. You can also search for other Help topics. When you are finished
exploring Help, close it and return to TK.
7. Press Esc to remove your entry or edit the name so TK can accept it.
8. Press Home to move to the top of the Plot Sheet. Home and End move you to the top
and bottom of a sheet.
9. Move the cursor to the Plot Type column. Notice that if you double click in this field,
a pull-down appears. Many different TK fields behave this way. In this case, choose
Line Chart. (As a shortcut, you can also type the first character of the choice you want.)
At this point, you have a Line Chart named p1 but you don't have any contents for it yet
(data, labels, scales, etc.).
Opening Subsheets and Editing Object Attributes
1. Click the right mouse button or press CTRL-D to open the subsheet for the p1 Line
Chart. Subsheets contain object definitions.

2. Enter abc as the X-Axis List name. TK created the object automatically on the List
Sheet. Look at the Navigation bar and see that a “+” is now shown beside the List Sheet
icon, indicating the sheet now has content.
Display Scale:
Yes
Display Zero Axes:
None
Display Grid:
No
Display Legend:
No
Line Chart Scaling:
Linear
Title:
Subtitle:
X-Axis Label:
Y-Axis Label:
X-Axis Minimum, Maximum
Y-Axis Minimum, Maximum
X-Axis List:
abc

3. Open the subsheet for the list abc (CTRL-D or right mouse click on the list name in
the plot subsheet or use the Navigation Bar). A list of values can be entered here in the
subsheet. Enter 1, then cursor down and enter 2, then 3, then 4, then 5 under the Value
heading. The element column automatically updates to let you know which line you are
on. Most sheets don’t have line numbers, however you can look in the lower left corner
of the TK screen and it is displayed regardless of where you are in the program.
Element
1
2
3
4
5

Value
1
2
3
4
5

4. Close the list subsheet.
5. Cursor down below the Y-Axis field and enter xyz as the name of the Y-Axis List.
Y-Axis
xyz

Style
Lines

Character
*

Symbol Count
0

First
1

Last

6. Open the subsheet for xyz and enter the values 2, 4, 7, 23, 89 in the first five rows,
then close the subsheet.
Element
1
2
3
4
5

Value
2
4
7
23
87

7. Use the Commands menu and select Display Plot or press F7. TK used the objects we
defined and created a plot by connecting the X,Y coordinates with lines.
Here’s the plot.
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8. Use the Navigation Bar to view the contents of the List Sheet. The List Sheet is the
storage place for any lists which have been created or imported from spreadsheet or
ASCII files. TK automatically placed the names abc and xyz on the List Sheet as soon as
we defined them on the plot subsheet.
9. Move the cursor over the xyz list and open the subsheet. This works in every sheet,
allowing you to check or define contents. There are several ways of viewing subsheets.
The object bar along the top provides pull-downs for each type of object. Close the
subsheet.
10. Next, open the Table Sheet using either the Navigation Bar. The Table Sheet is the
place where tables are defined and stored. Just like the Plot Sheet or any other sheet, we
can define several tables on the Table Sheet. Tables are collections of lists.
11. Enter t1 as the name of the first table then open the subsheet to further define this
new object.
12. Enter the names of the two lists we previously created, abc and xyz. By default, TK
assigns column widths of 10.
List
abc
xyz

Format

Width
10
10

Heading

13. Press CTRL-D or the Right Mouse Button to open the Interactive Table Subsheet,
t1.

Element
1
2
3
4
5

abc
1
2
3
4
5

xyz
2
4
7
23
87

14. These are the same values we entered earlier. Let's add another data point to our
plot. Move the cursor to the 6th row in the abc list and enter 6. Cursor over to the xyz
list and add another value by entering 8.5^2. TK evaluates this expression for us. In
fact, there is a calculator in every TK input field. Click on the down arrow in the upper
right corner of the subsheet to iconize the subsheet.
15. Use the Object Bar or Press F7 to bring the plot window to the top again. It now
displays all six pairs of data points.
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16. Pull down the Window menu and select Cascade. This will help you see all the
sheets and subsheets you have open. You might also try the Tile option.
17. Close all the Windows using the Windows Menu.
18. Use the tables listing in the Object Bar to open the table t1. The Object Bar saves
you the trouble of finding and opening individual sheets. It also helps keep the interface
from getting too cluttered when you’re working with many different types of objects.
19. Use the Navigation Bar to open the Plot Sheet. Highlight the first plot name, p1.
Use the View Menu and select Properties. There is also an icon available or you can
press ALT-ENTER to view properties. You can also click the right mouse button. Click
on the “tack” in the upper left corner of the properties box to keep it on the screen as you
move from object to object.

20. Any entries made in the Properties Box are automatically placed into the
corresponding object subsheets and will directly affect the object. Press F7 to bring the
plot p1 up on the screen. Click the Y-Log selection in the Properties Box. The plot
updates.
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